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Podstawy Systemow Mikroprocesorowych

Instalacja sSrodowiska programistycznego

System operacyjny Microsoft Windows

1. Instalacja toolchain-a: kompilatora, linker-a, narzedzi do budowania (avr-gcc) oraz oprogramo-
wania do programowania mikrokontroleréw (avrdude).

Istnieje kilka sposobd na instalacje oprogramowania do pracy z mikrokontrolerami AVR. Mozliwe jest

wykorzystanie oprogramowania udostepnianego przez producenta mikrokontroleréw (firma Micro-
chip), oprogramowania dystrybuowanego w pakiecie WinAVR - dostepny pakiet binarny jest bardzo
stary - z 2010r., zbudowanie wtasnego toolchain’a, wykorzystanie juz zbudowanego toolchain’a z

najnowszym kompilatorem avr-gcc. Wykorzystamy ostatnig opcje.

« Pobranie archiwum avr-gcc ze strony: https://blog.zakkemble.net/avr-gcc-builds/

i
A

« Rozpakowanie archiwum avr-gcc. Pobrane archiwum zip nalezy rozpakowac. Mozna kliknaé

Na chwile obecna najnowszy plik archiwum to: avr-gcc-10.1.0-x64-windows.zip Bezpo-

Sredni link do pobrania: avr-gcc-10.1.0-x64-windows.zip

Po rozpakowaniu archiwum zajmuje ok. 466 MB, dlatego upewnij sie, ze masz wiecej

wolnej przestrzeni dyskowe;.

prawym klawiszem myszy na archiwum i z podrecznego menu wybrac¢ “Wyodrebnij wszystkie”.
W polu pod napisem: Pliki zostang wyodrebnione do folderu, ustawié: C:\. A nastepnie kliknaé
przycisk Wyodrebnij.

+ Zostanie automatycznie stworzony katalog: C:\avr-gcc-10.1.0-x64-windows

« Nastepnie wejdz do: Panel Sterowania -> System i zabezpieczenia -> System i kliknij Zaawanso-
wane ustawienia systemu. A nastepnie w zaktadce Zaawansowane kliknij przycisk Zmienne
Srodowiskowe.

« W polu na dole Zmienne srodowiskowe wybierz zmienng Path i kliknij przycisk Edytuj

« W nowym okienku, przejdz na poczatek wartosci zmiennej i dopisz na poczatku nastepujacy tekst,
pozostawiajac reszte nie zmieniona: C:\avr-gcc-10.1.0-x64-windows\bin; Nastepnie kliknij Ok
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W Windows 10 zmienne Srodowiskowe ustawia sie nastepujaco: Ustawienia->System-
0 >Informacje, a nastepnie z prawej strony wybieramy Informacje o systemie. Nastepnie
po lewej wybieramy Zaawansowane ustawienia systemu i w okienku Wtasciwosci
systemu klikamy na przycisk Zmienne srodowiskowe, ktéry jest po prawej na dole
(Ewentualnie wyszukujemy Panel sterowania->System i zabezpieczenia—->System i
wybieramy po lewej Zaawansowane ustawienia systemu itd.). W otworzonym okienku
Zmienne srodowiskowe, w dolnym polu Zmienne systemowe wyszukujemy Path i kli-
kamy przycisk Edytuj znajdujacy sie pod polem wyboru. W okienku Edycja zmiennej
srodowiskowej klikamy przycisk po prawej Nowy i wpisujemy C:\avr-gcc-10.1.0-x64-

windows\bin i klikamy przycisk Ok.

« Wciénij (WinKey + R) - Uruchom, albo w Menu wpisz w polu: cmd

« Wpisz avr-gcc i nacisnij Enter

« Powininno pojawic sie: avr-gcc: fatal-error: no input files compilation terminated

- Swiadczy to o prawidtowym ustawieniu $ciezki dostepu - po wpisaniu gdziekolwiek komendy
avr-gcc, uruchamia sie wtasciwy program ze Sciezki

3. Instalacja edytora Geany

« Ze strony: https://www.geany.org/download/releases/ nalezy pobrac plik geany-
1.36_setup.exe

« Uruchomié program instalacyjny geany i zainstalowa¢ w standardowy sposéb wedtug domysl-

Na chwile obecng, najnowsza wersja geany to 1.36. BezposSredni link do pobrania: Geany
1.36

nych ustawien.

« Na pulpicie powinna pojawi¢ sie charakterystyczna ikonka: ,,z6ttej lampy’’. Po uruchomieniu
edytora, warto zapisac plik z rozszerzeniem .c - nastapi przetgczenie do kontekstu plikow zrodto-
wych jezyka C. Mozna wtedy skonfigurowac sobie skroty w menu: Zbuduj, wybierajac ostatnia
pozycje: Zdefiniuj polecenia budowania. Proponuje klikna¢ na pierwszy od gory, po lewej
przycisk i wpisaé: Make, a obok, gdzie jest polecenie wpisa¢ make. W ten sposob wciskajac
F8, bedziemy wykonywac¢ budowanie projektu. Drugi przycisk proponuje nazwac: Program, a
polecenie wpisaé: make program, w ten sposob wciskajgc F9, zaprogramujemy przygotowany
program w mikrokontrolerze. Trzeci przycisk od gory proponuje nazwa¢: Clean i wpisac polece-
nie: make clean. Nie ma on skrétu klawiszowego, ale zwykle nie trzeba z niego czesto korzystac,
wiec mozna go wywotywac z menu.

4. Instalacja sterownika programatora
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« Do programowania mikrokontroleréw AVR wykorzystamy programator USBasp, ze strony: https:
//www.fischl.de/usbasp/ Programator bedzie obstugiwany przez oprogramowanie avrdude,
ktére zainstalowato sie razem z narzedziami z punktu 1. Nie potrzeba zatem pobierac nic ze
strony tworcy programatora.

+ Do obstugi programatora w systemach MS Windows konieczna jest instalacja sterownika (skoja-
rzenie VID/PID z biblioteka libusb. W tym celu najwygodniej skorzystaé z oprogramowania Zadig,
ktore nalezy pobrac ze strony: https://zadig.akeo.ie/

« Podtaczy¢ programator do komputera poprzez ztgcze USB.

Na chwile obecna, najnowsza wersja to 2.5. Bezposredni link do pobrania: https://gith
ub.com/pbatard/libwdi/releases/download/b730/zadig-2.5.exe

« Po uruchomieniu programu zadig, pojawi sie okienko, w ktérym nalezy wybra¢ sterownik. W
zaleznosci od systemu niektére sterowniki dziataja, a z niektérymi sg problemy. Za pomoca
programu zadig mozna w tatwy sposéb zmieniac te sterowniki.

« Upewnijsie, ze w polu wyboru posrodku widnieje: USBasp, Vendor ID ma wartos$¢ 16c0, a Product
ID ma wartos$¢ 05dc (wartoSci obok etykiety USB ID). Jesli nie to sprobuj kliknaé na to pole i
wybra¢ USBasp. Jesli mimo to nie widaé programatora, to odpig¢ programator od gniazda USB
w komputerze i jeszcze raz podtaczyd.

« Przy strzateczce, nad duzym przyciskiem, Wybierz sterownik libusbK i naci$nij duzy przycisk
pod spodem Install Driver). Jesli bedzie zmiana sterownika to etykieta przycisku zmieni sie
na Replace Driver. Operacja moze chwilke zaja¢ - po chwili powinno wyskoczy¢ okienko z
informacja o prawidtowo zainstalowanym sterowniku.

5. Test dziatania programatora

« Proponuje utworzy¢ katalog z Projektami, i kazdy kolejny tworzony projekt nazywac wg numeru
zajec, np z0_test, z1_gpio, itd. Ponadto rézne warianty tworzonych programéw proponuje takze
umieszcza¢ w osobnych katalogach i dodawac w nazwie kolejny numer.

« W katalogu z0_test umiesci¢ plik Makefile przeznaczony dla systemu Windows, do pobrania ze
strony laboratorium: AVR Makefile dla Windows

g Uwaga! Prosze zwrdci¢ uwage, czy plik Makefile nie zapisat sie np. z rozszerzeniem
.txt. Wazne jest aby nie byto dodanego rozszerzenia. Plik musi nazywac sie po prostu
Makefile i musi znajdowac sie w tym samym katalogu, co plik main.c.

« Stworzy¢ w katalogu z0_test plik main.c, w ktérym nalezy umiescic¢ kod testowy, mrugajacy
dioda LED podtaczona do pinu PCO:
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é Uwaga! Ponizszy kod zrodtowy najlepiej jest recznie wpisac¢ w edytorze, gdyz po skopio-

#inc
#inc

int

waniu zamiast znakow z puli kodow ASCII, pojawig sie znaki rozszerzone z puli UTF-8,
ktore nie beda wtasciwie interpretowane przez kompilator, np. znak ~. W wyniku czego
podczas kompilacji wysSwietli sie komunikat o btedzie, ktory trzeba bedzie poprawic.

lude<avr/io.h>
lude<util/delay.h>

main(void) {

DDRC=0xff}
PORTC=0xfTf;

while(1){
PORTC"=(1<<PC0);
_delay_ms(500);

return 0O;

Wykonaj polecenie make (klawisz F8 lub wtasciwa opcja z menu Zbuduj). Prawidtowe budowa-
nie nie powinno zgtosic btedéw. Informacje na korcu powinny zawiera¢ wielko$¢ utworzonego

pliku elf.
Podtacz przewodem Z-7 (zefisko-zefiskim), pin PCO z pierwszym pinem ze ztgcza LEDS

Podtacz programator USBasp do ptytki EvB 5.1 do ztgcza ISP kablem - tasiemka (ztacza typu
KANDA), zwr6¢ uwage na klucz w ztgczu uniemozliwiajgcy odwrotne podtaczenie. Na tasiemce

czerwonym kolorem zaznaczona jest pierwsza linia.

Podtacz programator USBasp do komputera PC przez ztacze USB. W efekcie na ptytke EvB
5.1 powinno zosta¢ podane zasilanie (+5 V), ktore spowoduje zaswiecenie sie ekranu LCD i
ewentualnie diody LED. Moze takze dziata¢ demonstracyjny program, ktéry bedzie mrugat
diodami LED.

Wykonaj polecenie make program (klawisz F9). Wynikiem powinno by¢ bezbtedne zaprogramo-
wanie mikrokontrolera, jego reset i uruchomienie naszego testowego programu. PowinniSmy
widziec¢ zapalanie sie diody LED z okresem 1 sekundy.

. Instalacja Srodowiska Eclipse

Pobrac werse Eclipse z zainstalowanym CDT (przeznaczong do tworzenia aplikacji C/C++)
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0 R6zne pakiety Eclipse dostepne s3 do pobrania na stronie: https://www.eclipse.org/do
wnloads/packages/
Obecnie najnowsza wersja to 2020.09, ktérg mozna pobraé bezposrednio z: Eclipse CDT
2020.09

« Rozpakowac archiwum zip Eclipse. Kliknaé prawym klawiszem na pliku zip, a nastepnie wybrac
Wyodrebnij wszystkie. Poniewaz archiwum zawiera podkatalog eclipse, wystarczy w polu
miejsca docelowego wybrac dysk, np.: C:\

« Dla wygody mozna stworzy¢ odnos$nik na pulpicie, poprzez klikniecie prawym klawiszem myszy
i wybranie Nowy -> Skrot a nastepnie wskazanie pliku C:\eclipse\eclipse.exe

W Windows 10 nie ma dostepnego srodowiska JDK Java, ktore jest niezbedne do urucho-
A mienia Eclipse. Nalezy zatem pobraé srodowisko ze strony https://jdk.java.net. Najnow-
sze dostepne srodowisko ma numer 15. Link do pobrania bezposrednio: JDK 15. Nalezy
klikng¢ prawym klawiszem myszy na pobrane arichiwum i z menu wybraé Wyodrebnij
wszystkie. Nastepnie w polu docelowym wpisaé C:\. Archiwum zostanie rozpakowane
do C:\jdk-15. Ponownie nalezy dotaczyc sciezke do zmiennych Srodowiskowych (patrz

opis do instalacji avr-gcc). Nowa Sciezka, ktora trzeba dodac to: C:\jdk-15\bin.

« Uruchomi¢ program Eclipse, a nastepnie w menu Help wybrac Eclipse Marketplace

« W polu Find wpisac avr i wyszukac

« Zainstalowa¢ dodatek: AVR Eclipse Plugin 2.3.4 - w tym celu nalezy zgodzic¢ sie na warunki
licencyjne i nacisna¢ przycisk Finish. Potem zezwoli¢ na instalacje oprogramowania ,,niepod-
pisanego’’ Install anyway. Eclipse po instalacji zaproponuje swoje ponowne uruchomienie:
Restart Now, na co nalezy sie zgodzic.

7. Przetestowanie Srodowiska Eclipse CDT wraz z zainstalowanym wczesniej oprogramowaniem
avr-gcc i avrdude

AVR Eclipse Plugin ma drobne wady, ktére nalezy poznaé, tworzac projekt nowego programu na
mikrokontroler. Jedna z nich jest brak domyslnie wybranej opcji optymalizacji kompilacji dotyczacej
minimalizacji wielko$ci utworzonego programu. Jest to opcja, ktdra na mate mikrokontrolery jest
stosowana domyslnie.

Zacznijmy od dostosowania Eclipse.

« Usuniecie Launch Bar. W przypadku programowania mikrokontrolerow AVR, jest on nieprzy-
datny i tylko zajmuje miejsce. Wybierz z menu u géry, Window->Preferences—>Run/Debug-
>Launching->Launch Bar i odznacz checkbox Enable Launch Bar, a nastepnie kliknij przycisk
Apply and Close.
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/*
*
*
*

*

*/

« Ustawienie autora programu i czasu zapisu. Wybierz z menu u géry, Window->Preferences-
>C/C++->Code Style->Code Templates—> i w okienku obok wybra¢ Comments —> Files, a na-
stepnie klikna¢ przycisk Edit. Zapisz wzorzec wg nastepujacego schematu, oczywiscie wpisujac
swoje dane (imie, nazwisko, e-mail) w pole Author:.

Project: ${project_name}
File: ${file_name}

Created on: ${date} ${time}
Author: Dariusz Tefelski <dariusz.tefelski@cern.ch>

« Ustawienie automatycznego zapisu plikow przed budowaniem. Wybierz z menu u géry Window-
>Preferences->General->Workspace—>Build i zaznacz checkbox obok Save automatically
before manual build. Naci$nij Apply and Close.

« Umozliwienie wpisywanie polskiego znaku ,,¢’’ (problem dotyczy Windows 7, pod Linux-em
AltGr+c daje ,,¢). Nalezy wej$¢ do Window->Preferences—>General->Keys i odnalez¢ ko-
mende Insert ChangeLog entry. Obok w kolumnie Bind bedzie widoczna kombinacja klawiszy
Ctrl+Alt+C. Bedg widoczne 2 takie komendy. W obu przypadkach nalezy, po zaznaczeniu ko-
mendy, klikng¢ na przycisk Unbind Command. Na koniec nacisng¢ Apply and Close. W ten
spos6b pozbedziemy sie tego skrotu klawiszowego, do nieuzywanej funkcji, a w zamian bedzie
mozna korzystaé z polskiego znaku ,,¢”.

« Usuniecie kontroli pisowni. Sprawdzanie pisowni - ortografii w wiekszosci przypadkow przy
pisaniu kodu niepotrzebnie rozprasza - zwtaszcza, gdy przygotowujemy fragmenty tekstu, albo
komentarze w innych jezykach niz angielski. Nalezy wejs¢ do Winow->Preferences->General-
>Editors->Text Editors—>Spelling i odznaczy¢ checkbox Enable spell checking. Na koniec
nacisna¢ Apply and Close

« Utworzmy projekt programu dla mikrokontrolera AVR ATmega32. Nalezy wybra¢ w menu u gorze:
File->New->Project..., albo klikna¢ prawym klawiszem myszy w polu Project Explorer i wy-
bra¢ New->Project.... Nastepnie w zaktadce C/C++ wybra C Project. Wpisac nazwe projektu
np. “Startowy1”, a w polu Project Type otworzy¢ AVR Cross Target Application i wybra¢ Empty
Project. W polu Toolchains powinien by¢ zaznaczony AVR-GCC Toolchain. Nacisna¢ przycisk
Next. W kolejnym oknie w polu Configurations odznaczy¢ checkbox Debug (Srodkowe pole),
gdyz nie bedziemy z niego korzystac. Pozosta¢ ma natomiast Release. Mozemy w tym momencie
klikna¢ Finishi potem “wygodniej” ustawi¢ typ mikrokontrolera i czestotliwo$¢ zegara, albo
klinka¢ Next i w nastepnym oknie wybraé MCU Type jako ATmega32 i w polu MCU Frequency
(Hz) recznie wpisac 16000000 i zakonczy¢ przyciskiem Finish.
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Wazne ustawienia w utworzonym projekcie

+ Ustawienie optymalizacji rozmiaru kodu wykonywalnego. To ustawienie dotyczy otwartego
projektu. Nalezy w Project Explorer kliknag¢ prawym klawiszem myszy na utworzonym pro-
jekcie np. “Startowyl1” a nastepnie wybranie z menu Properties, i dalej w otwartym oknie, po
lewej wybranie C/C++ Build->Settings, a nastepnie w zaktadce Tool Settings otworzy¢ AVR
Compiler—>Optimization i po prawej w polu Optimization Level zamiast No Optimizations
(-00) wybrac Size Optimizations (-Os). Na koniec nacisna¢ Apply and Close.

+ Ustawienie dotaczania tylko wymaganych funkcji z bibliotek, a nie dotaczanie catego kodu
biblioteki w trakcie taczenia (linkowania) plikbw wynikowych. Nalezy w Project Explorer klikna¢
prawym klawiszem myszy na utworzonym projekcie np. “Startowyl” a nastepnie wybranie
z menu Properties, i dalej w otwartym oknie, po lewej wybranie C/C++ Build->Settings, a
nastepnie w zaktadce Tool Settings otworzy¢ AVR C Linker->General a nastepnie w polu Other
Arguments po prawej dodac: -Wl,--gc-sections. Na koniec nacisna¢ Apply and Close.

« Ustawienie wtasciwego typu mikrokontrolera (jesli nie zrobilismy tego wczesniej) i czestotliwosci
zegara. Nalezy w Project Explorer klikna¢ prawym klawiszem myszy na utworzonym projekcie
np. “Startowyl” a nastepnie wybranie z menu Properties, i dalej w otwartym oknie, po lewej
wybranie AVR->Target Hardware i w polu MCU Type wybranie ATmega32 a w polu MCU Clock
Frequency wybranie 16000000. Na koniec nacisna¢ Apply and Close.

« Ustawienie programatora dla programu AVRDude. Nalezy w Project Explorer klikngé prawym
klawiszem myszy na utworzonym projekcie np. “Startowyl” a nastepnie wybranie z menu Pro-
perties, i dalej w otwartym oknie, po lewej wybranie AVR->AVRDude i w zaktadce Programmer
configuration nalezy klikna¢ przycisk New. W otwartym oknie u gory w polu Configuration
name nazwac programator np. USBasp, a w polu Programmer Hardware (-c) wybra¢ USBasp,
http://www.fischl.de/usbasp/, a nastepnie kliknaé przycisk OK w prawym dolnym rogu okna.
Na koniec nacisna¢ Apply and Close.

+ Usuniecie zbednej weryfikacji zaprogramowanego kodu w mikrokontrolerze. Nalezy w Project
Explorer klikngé prawym klawiszem myszy na utworzonym projekcie np. “Startowyl” a nastep-
nie wybranie z menu Properties, i dalej w otwartym oknie, po lewej wybranie AVR->AVRDude i
w zaktadce Advanced w polu Verify Check (-V) nalezy zaznaczy¢ checkbox Disable automatic
verify check. Na koniec nacisng¢ Apply and Close.

« Przygotowanie nowego pliku w projekcie. Nalezy klikngé prawym klawiszem myszy w Project
Explorer na projekcie “Startowyl” a nastepnie wybra¢ w menu New->Source File. W otwartym
oknie, w polu Source file: wpisa¢ main.c. W polu Template powinien by¢ Default C source
template. Nacisna¢ Finish. W projekcie pojawi sie nowy plik main.c i zostanie on takze otwo-
rzony w edytorze w centralnej czesci Eclipse (jesli jesteSmy w perspektywie C/C++).
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Wpiszmy ponownie prosty kod testowy, mrugajacy dioda LED, tym razem zmieniajac czestotliwosé
mrugania przez zmiane op6znienia na 100 ms. Przypominam, ze w Eclipse mozna tatwo skorzystaé z po-
mocy (automatyczne uzupetnianie, sugerowanie rozwigzan) poprzez skrét klawiszowy Alt + Space.:

#include<avr/io.h>
#include<util/delay.h>

int main(void){

DDRC=0x f
PORTC=0xff;

while(1){

PORTC"=(1<<PC0O);
_delay_ms(100);

return 0;

Uwaga, na kopiowanie kodu z instrukcji - niektore znaki zle sie kopiuja (powstajg niewta-

A

« Zbudowac projekt mozemy uzywajac przycisku z ikong mtotka w menu u goérze (albo kombinacja

Sciwe znaki), wiec lepiej przepisaé kod recznie.

klawiszy Ctrl+ B - z tym, ze budowanie realizuje wszystkie projekty, ktore sg otwarte - i czasem
moze okazaé sie wygodniej ustawic skrot np. klawisz F7 do budowania tylko aktywnego (za-
znaczonego) projektu. Opcja w Window->Preferences->General->Keys. Wyszuka¢ komende
Build Project, zaznaczy¢ i w polu Binding nacisnac klawisz np. F7. Na koniec nacisna¢ Apply
and Close.

« Zaprogramowac mikrokontroler mozemy uzywajac przycisku z napisem AVR i zielong strzatka w
dét, albo mozemy uzy¢ skrétu klawiszowego: Ctrl + Alt + U.

« Po wgraniu programu do mikrokontrolera powinnnismy zaobserwowa¢ mruganie diody LED
o wiekszej czestotliwosci. Mozna sprobowad zmieni¢ opdznienie i sprawdzic jak dioda bedzie
mrugad.

@ Jaka czestotliwos¢ mrugania diody LED w Hz uzyskamy przy wprowadzonym opdznieniu
- w ms?

8. Instalacja wirtualnego portu szeregowego. Na ptytce prototypowej port szeregowy jest tagczony z
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konwerterem USB/RS232 - jest to uktad Future Technology FTDI FT232RL, ktory powinien byé
rozpoznawany przez Windows i sterowniki powinny zostac zainstalowane automatycznie. Jesli
tak nie jest nalezy pobrac sterownik ze strony: https://www.ftdichip.com/Drivers/VCP.htm i
wskazac wyodrebnione pliki przy instalacji sterownika, albo postuzy¢ sie wersja z instalatorem:
Setup.

+ Do obstugi portu szeregowego z poziomu Windows przyda sie instalacja odpowiedniego opro-
gramowania, proponowane to:

- bray terminal
- realterm

- hterm

- yat

- termie

- termite

- putty

System operacyjny GNU/Linux

Systemy operacyjne GNU/Linux sa lepiej dostosowane do wykorzystania jako Srodowisko programi-
styczne. W wiekszosci przypadkéw wystarczy zainstalowac potrzebne pakiety z dystrybucji systemu.
Najczesciej beda to pakiety o nazwach avr-gec, avrdude, avr-libc, avr-binutils. W r6znych dystrybu-
cjach moga miec troche inng nazwe, ale zwykle pomaga wyszukanie avr.

« W dystrybucji Mabox Linux (ewentualnie Manjaro albo ArchLinux) odpowiednio wyszukuje sie
przez:

pacman -Ss avr

ainstaluje przez np.

pacman -Sy avr-gcc avrdude avr-libc avr-binutils geany make

Podobnie jest w innych dystrybucjach, np w Ubuntu/Debian, wyszukanie poprzez:

apt search avr

ainstalacja np. przez
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apt install geany

W dystrybucjach opartych na Red Hat Linux
yum search avr

albo (Fedora)

dnf search avr

i podobnie instalacja jak wyze;j.

« Konfiguracja srodowiska Eclipse jest praktycznie identyczna jak przedstawiona w instalacji dla
systemu MS Windows.

« Istotnag kwestig pracy w systemie GNU/Linux jest nadanie uprawnien dla uzytkownika do wykorzy-
stania urzadzen podtaczanych z zewnatrz. We wspotczesnych dystrybucjach jest to realizowane
przez rozpoznanie podtgczanego urzadzenia i nadanie uprawnien wg plikow konfiugracyjnych
umieszczonych w katalogu [etc/udev/rules.d. W tym celu nalezy utworzy¢ jako root w tym
katalogu plik o nazwie 50-usbasp.rules zawierajacy nastepujaca konfiguracje.

# AVR USBASP
SUBSYSTEM!="usb", ACTION!="add", GOTO="usbasp_end"

SUBSYSTEMS=="usb", ATTRS{idVendor}=="16c0", ATTRS{idProduct}=="05dc",
MODE="660", GROUP="uucp"

LABEL="asbasp_end"

g Uwaga! W plikach udev kazda linia jest traktowana jako reguta, w powyzszym pliku
MODE=“660", GROUP=“uucp”, musi znalez¢ sie w jednej linii z SUBSYSTEMS==“usb”.

({3}

“I=" oznacza sprawdzenie “czy jest r6zne”, natomist pojedyncze “=” oznacza dziatanie -

o W plikach udev, w regutach “==" oznacza, sprawdzenie, czy cos$ jest spetnione, podobnie
przypisanie, np. MODE=“660" oznacza nadanie praw do odczytu i zapisu dla wtasciciela

(root-a) oraz dla grupy ( w naszym przypadku uucp ).
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Jest ona przygotowana dla systemu opartego o Archlinux. Dotyczy to nazwy grupy, do ktorej bedzie
przydzielone urzadzenie. W Archlinux(Mabox Linux, Manjaro) grupa ktdra moze korzystac z urzadzen
szeregowych (portoéw), to uucp. W innych dystrybucjach jest inna nazwa, np. w Debianie / Ubuntu
i pochodnych jest to grupa dialout. Wystarczy w ponizszym pliku zmieni¢ nazwe Group=“uucp” na
Group="“dialout”.

Aby uzytkownik systemu mogt skorzystaé z programator USBasp musi naleze¢ tez do stosownej
grupy.
Polecenie groups w terminalu, pokaze do jakich grup nalezy uzytkownik.

Uzytkownika mozna doda¢ do grupy przez:
sudo usermod -a -G uucp darek
Gdzie oczywiscie na koAcu jest nazwa naszego uzytkownika. Dla Debian/Ubuntu bedzie to:

sudo usermod -a -G dialout darek
« Po ustawieniu grupy najlepiej sie wylogowac i zalogowac ponownie. Jesli pracujemy tylko w
jednym terminalu - tymczasowo mozemy wskazaé, ze mamy wtasciwg grupe, poleceniem:
newgrp uucp
Ale to zadziata tylko w tym jednym terminalu, w kazdym innym trzeba bedzie ponownie jg wpisywac,
do czasu wylogowania i zalogowania ponownie, gdzie bedzie to juz utrwalone na state.

« Plik Makefile dla systemu GNU/Linux: AVR Makefile dla Linux

« Aplikacje do potaczenia poprzez port szeregowy:

moserial
- cutecom
- hterm
- gtkterm
- picocom
- minicom
- screen
- putty

Po podtaczeniu ptytki prototypowej kablem USB A-B do komputera, mozliwe bedzie wykorzystanie
wirtualnego portu szeregowego do transmisji danych z i do mikrokontrolera. W tym momencie port
dostepny bedzie jako urzadzenie [dev/ttyUSBO.
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System operacyjny macOS

Ze wzgledu na to, ze system macOS na komputerach Apple oparty jest o jadro Unix-owe: NetBSD, kwe-
stia wykorzystania tego systemu do programowania mikrokontroleréw AVR powinna by¢ na podobnym
poziomie trudnosci co dla systemu GNU/Linux.

Jednakze nie mam doSwiadczenia zwigzanego z ta platforma. W internecie dostepne sg r6zne materiaty
dotyczace programowania AVR pod macOS, np. po polsku http://marcingibas.pl/poradniki/6-jak-
rozpoczac-programowanie-avr-na-macos.
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